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In 1978 when Winestate Magazine began it was to set the 
benchmark for other industry publications to try and match.

Several decades later, many of those other publications have 
been and gone while Winestate has remained and is the 
leading independent Wine Magazine in Australia.

Going back a over 40 years, Australia had 171 wine and 
brandy producers. It was not impossible for a serious taster 
to get to know most of them. Today, Australia has more than 
2,500 wineries. That’s more than ten times as many. This is 
why we at Winestate Publishing employ informative quality 
journalists and feature columnists who are knowledgeable in 
the goings on of each particular wine region. They give our 
publications an array of credible and interesting articles on 
upcoming events, personality profiles, new and old wineries, 
cellar doors and restaurants and other interesting and 
informative topics all in an easy to read format.

We have a number of different publications particularly 
tailored to suit different market segments:

• Winestate Magazine

• The Wine & Spirit Insider

• Winestate On -line  
(Our Consumer Website www.winestate.com.au)

Winestate magazine is a consumer wine buying guide aimed 
squarely at those looking to buy wine for their home cellar, 
their restaurant or for their bottle/liquor store.

Its primary focus is on the Australian reader and has a print 
circulation base of 25,000 with an estimated readership 
of over 60,000. Increasingly, on-line partnerships with Le 
Cordon Bleu, Sydney Wine Academy, William Angliss College 
and other teaching alumni have added another 100,000 to 
our audience. In future, we are looking to build our China 
audience to over, 1 million. Already we have AWSEC Hong 
Kong/China’s biggest wine education group involved with over 
150,000 alumni.

Its readers are influencers within their peer groups and as 
such the magazine impacts on a wide-ranging audience. 
Particular areas of influence include wine buyers, wine 
investment, wine tourism and the restaurant scene. For the 
trade we have secured on-line partnerships with Hospitality 
magazine, Australian Hotels Association, Restaurant & Catering 
Association and for New Zealand the Restaurant & Catering 
Association and the First Glass Wine Show audience, thereby 
making Winestate also the most widely circulated magazine in 
the liquor trade.  

about us

This magazine is sold and distributed through newsagents and by 
subscription to readers across the globe and through selected 
liquor retailers across Australia. Winestate’s sales concentration 
is in the larger cities and their high-income suburbs.

Regular Sections.

• Grapevine / Dining stories & latest reviews from around 
Australia & New Zealand.

• Wine Tutor

• Wine Investment & Collecting

• What’s its Worth – Auction Section.

• New Releases

• Varietal Style tastings (eg: Shiraz etc)

• Regional tastings (eg: Barossa, Hunter Valley etc.)

• Wine & Spirit Insider – Beers, Spirits & Value Wine Buys.

• Wine Travel & Tourism

Winestate’s first issue May 1978!
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Winestate Magazine is distributed in Australia & New Zealand 
through Gordon and Gotch. Australia’s largest independent 
magazine distributor. Servicing newsagents and newsstands 
using their expertise in distribution.

They have the largest range of magazines in Australia, and 
provide this service to over 300 publisher clients through 
more than 8000 retail outlets. Over 190 million magazines are 
distributed into the Australian marketplace each year, which 
has a total retail value of over $600 million.

Gordon and Gotch have an extensive database of 
approximately 3400 different magazines across a broad range 
of categories. Each month their warehouses around Australia 
distribute over 17 million magazines.

Winestate for many years has been the number one selling 
magazine in the Wine & Spirit category for Gordon & Gotch 
on the news stands.

wine & spirit category

Winestate Magazine Ranked Number 1 
in Wine & Spirit Category

food & wine category

Winestate Magazine Ranked Number 6 
in Food & Wine Category

Note from Gordon & Gotch
In relation to the Category info, we have 
provided both the main category (Food & 
Wine) and the sub category (Wine & Spirits). 
You will see notated on each category 
where Winestate is ranked in the category. 
It should also be pointed out, these are of 
course Gordon & Gotch titles only and not 
reflective of the entire Australian market.

NUMBER ONE
selling magazine in wine & spirit category



3

As the world’s biggest buying guide to Australian & New 
Zealand Wines our aim is to promote those wines that 
achieve the highest results in our tastings.

People are quite often surprised at the amount of work we do 
behind the scenes to not only promote ourselves through the 
many wines submitted and published in our magazine, but also 
to support & sponsor other exhibitions held around the world.

Over the past few years we have supported events such as 
Wine Australia and been media partners with the Good Food 
& Wine Show and the Adelaide Festival of Arts. Every year we 
send one of our team to VinItaly and showcase a selection of 
wines from across Australia and New Zealand at the World’s 
Largest Wine Show!

Recent sponsorships and media partnerships include the:

Wine & Spirit Asia Singapore  
www.foodnhotelasia.com

Hong Kong International Wine & Spirits Fair  
www.hktdc.com

Vinexpo Hong Kong  
www.vinexpodaily.com

Japan Wine & Gourmet Exhibition  
www.wineandgourmetjapan.com

Vinitaly 
www.vinitaly.com

Adelaide Festival  
www.adelaidefestival.com.au

Top Wine China 
www.topwinechina.com

By supporting these exhibitions and other promotions we believe 
that it is doing our bit to help keep the interest in Australian 
& New Zealand wines to the fore and, of course, it helps the 
profile of Winestate to be seen at these prestigious events.

We are delighted that our magazine reaches these important 
overseas buyers and that they can use Winestate to help with 
their buying decisions including keeping abreast of the new 
wines coming onto the market. 

sponsors events globally
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Winestate is a sponsor of the National Wine Centre and 
holds a number of VIP tasting events for our readers as well 
as being involved in many charity tastings such as the Alfred 
Hospital, Breast Cancer Research, Prostate Cancer and more. 
At the same time exposing new wines to people who have 
an interest in wine. We were very proud to have had nearly 
700 different shiraz wines available for tasting at the World’s 
Greatest Shiraz Challenge public tasting at the National Wine 
Centre in Adelaide each year. This is the biggest tasting of 
its kind, with submissions from international producers, with 
more entrants from France, New Zealand and South Africa.

public tasting events

At these Winestate Magazine Events we have over 500 wine 
buffs in attendance sampling the full range of wines submitted 
to our tasting. We do have a number of other events 
throughout the year which we have arranged to coincide with 
our tastings and have given these events to various charities as 
fund raising opportunities. By creating these events it gives us 
a further opportunity to promote those wines submitted to 
tastings and encourage sampling of brands that many people 
have not seen before. Many of the guests on the evenings 
busily jot down shopping lists of what to buy when next 
purchasing wine.
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Point of Sale 
Use copies of our Insider for your sales team to set up 
promotional displays and prove to retailers that your products 
are being promoted.

Third Party Endorsement 
Our reputation of calling it how we see it, built up over more 
than 4 decades gives your product the street cred and the 
independent voice to move recommended products into bars, 
restaurants, and liquor stores.

On line Promotions 
We can run promotions on-line to add value to your 
existing campaign. There are a number of different ways of 
integrating our print and online services. 

Wine Clubs 
We often use surplus wines from our tastings for smaller wine 
club tastings again exposing new wines to consumers who may 
not have thought of sampling from those varieties or regions.

Advanced Trade Information 
We send out our reviews in advance to Liquor retailers so 
they can place orders prior to our publications hitting the 
newsstands. Our list contains winery contact information so 
it is easy for the stores to place orders. This is done usually 
6-8 weeks prior to publication. 

added value & promotions for wineries
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Readership Places of 
Distribution

Target 
Audience

Demographic 
Snapshot

Winestate 
Magazine

82,000

Newsagents

Subscriptions

Wine Club Promotions

Wine Buyers
60% Male Skewed

25 -60 years of age

Wine & Spirit 
Insider

96,000

Inside Winestate 

Independent liquor stores

Chain Liquor Stores

Restaurants 
(Aust, NZ, Singapore, 
Hong Kong)

Wine & Spirit 
Buyers

57% Male

43% Female

18 – 45 years of age

Winestate
On-line

94,935

page views per month
Online only Wine Buyers

60% Male Skewed

25 -60 years of age

Custom
Publications

Variable on application

Tourism offices. 

Point of Sale

On-line

Wine Buyers Variable on application

E-Newsletter Can be customised E-mail
Wine Buyers

Trade Subscribers
Variable on application

winestate publishing readership snapshot
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Age groups

Under 25 11%

25 to 39 28%

40 to 54 49%

Over 54 12%

Total 100%

Male/Female Splits

Male 60%

Female 40%

Total 100%

Level of interest in wine

Beginner 9%

Casual 25%

Serious 66%

Total 100%

Winestate readers are influencers within 
their peer groups; as such the magazine 
impacts on a wide-ranging audience. 

Particular areas of influence include wine 
buyers, wine investment, wine tourism and 
the restaurant scene.

Average price paid for bottle of wine

Less than $10 8%

$11 to $20 44%

$21 to $50 42%

More than $50 6%

Total 100%

How frequently wine consumed

Daily 28%

Several times per week 65%

Once per week 2%

Less than once per week 5%

Total 100%

Relationship to Wine

Consumer 69%

Trade Buyers 22%

Winery 6%

Other 3%

Total 100%

Type of wine most often consumed

Red wine 52%

White Wine 14%

About the same of each 34%

Total 100%

readership profile
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Winestate has a national and international circulation 
base. Sold at news stands, bookstores, liquor stores and 
by subscription, Winestate’s sales concentration is in 
the larger cities and their high-income suburbs.

Available at news stands in the UK, US, New Zealand, 
Singapore, Hong Kong and more.

Also available in the business lounges of Qantas, Virgin 
Australia, Malaysia Airlines, Singapore Airlines, Qatar, 
Cathay Pacific and South African Airways lounges.

MarketAsia Singapore 
Distributes across news stands in Singapore

Winestate Overseas Distribution

USA EUR NZ ASIA Other

Winestate  Distribution by Country

USA EUR NZ ASIA Other Australia

Winestate Distribution by Region

NSW/ACT VIC SA/NT QLD
TAS WA Overseas

distribution winestate publishing
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Tasting venues Tastings will be held at Winestate’s Adelaide 
office unless otherwise notified. If tastings are to be held 
elsewhere, companies will be advised by fax or e-mail of 
revised dates and venue details.

Sample Quantities Please supply TWO sample bottles of 
each wine. The second bottle will be used should the first 
have fault. Prices Please provide RECOMMENDED RETAIL 
or cellar door PRICES when submitting, and please indicate 
clearly WHICH TASTING the samples are intended for as 
well as your CONTACT DETAILS, PHONE, FAX, E-mail and 
WEBSITE ADDRESS.

Tax Invoice for entry fee to be included with samples.

Availability All submissions must be bottled final blend. All 
must be available to the public when the issue is published.

Regional Tastings Any wine, including fortified, is eligible, 
provided that it has at least 85 per cent regional fruit content.

Style Tastings 85 per cent of a wine’s fruit content must be 
varietal for it to be tasted as STYLE; wines less than 85 per 
cent varietal will be tasted as BLENDS within the class of 
their dominant grape. Where blends of varieties are roughly 
equal, please show whether the product should be tasted in a 
varietal class, or as a generic blend.

New Release Tastings are open to any style, variety or region.

Submission documents are located at www.winestate.com.au

star rating system

tasting submissions & procedures

h o w  w e  c o m p a r e

Winestate Rating Comment Wine show Medal
International  
20 Point System

100 Point System

HHHHH Outstanding Gold 18.5 - 20 97 - 100

HHHH1/2 Excellent High Silver 18 - 18.4 95 - 96

HHHH Very Good Silver 17 - 17.9 93 - 94

HHH1/2 Good/Very Good High Bronze 16.5 - 16.9 91 - 92

HHH Good Bronze 15.5 - 16.4 89 - 90

Wine judging is an inexact art, not a science - even at the highest levels of proficiency. Accordingly, Winestate uses the star rating 
system which reflects a range, rather than a specific point score. Point systems indicate a level of accuracy that simply does not exist.
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Winestate Magazine
Regional Features

Tasting 
Submission 
DEADLINE

Winestate Magazine
Style Features

Tasting 
Submission 
DEADLINE

Tasting Submission 
DEADLINE

MAY2021

      /June

Wines of NSW

McLaren Vale & Fleurieu (incl 
Langhorne Creek & Kangaroo 
Island)

Western Australia

early February

early February

early January

New Releases late February

North Island (Wairarapa, Gisborne, Auckland & Northland) * Best of the West - PUBLIC TASTING TBA

JULY2021

      /August

River Regions

Adelaide Hills

early March

early March 

 

Fortified & Sweet White 
Wines

Cabernet Sauvignon  
& Blends

Bordeaux Blend Varieties, 
Merlot, Cab Franc, Malbec, 
Petit Verdot

Organic Wines

early March

mid April 

mid March

mid March

New Releases late April

South Island (Nelson, Canterbury)

SEPTEMBER2021

      /October

Limestone Coast

Clare Valley

early May

early May
Shiraz/Syrah & Blends 

Semillon & Blends 

Pinot Noir

Emerging Varietal Awards 
(EVA)

late May

early May

early May

early May

New Releases late June

Otago (Central Otago & Waitaki Valley/Nth Otago NZ) *Worlds Greatest Shiraz/Syrah Challenge - PUBLIC TASTING TBA

NOVEMBER2021

      /December

Tasmania

Queensland

early July

early July
Dry Riesling & Blends

Sauvignon Blanc & Blends

Pinot Gris/Grigio

Sparkling Wines

Rosé

early July

early July

early July

early July

early July

New Releases late August

Hawkes Bay (NZ) *World Cabernet Challenge - PUBLIC TASTING TBA *Emerging & Alternative Varietals - PUBLIC TASTING TBA

ANNUAL &  
Wine of the 
Year Awards
January/
February2022

Wine of the Year Awards  
Taste-off Trophy Judging 
Results*

early September

early September

New Releases early September

*Wine of the Year Awards - PUBLIC TASTING TBA

All the four- to five-star wines of 2021 in review.
Re-released in July 2022

See www.winestate.com.au/submit-your-wines/wines-
submitted-by-regional-varietal-speciality-tastings/  
for updates  *Tasting dates and deadlines are subject to change

2022 - MARCH
                 /April

Barossa Valley, Eden Valley

Central & Western Victoria

early Oct 2021

early Oct 2021
Chardonnay & Blends

Italian & Spanish Varietals 
 

early Oct 2021

early Oct 2021 

New Releases early Nov 2021

Marlborough (NZ)  For New Zealand regional tasting submission deadlines, please contact Kay Morganty - kmorganty@winestate.com.au

tasting & special features 2021



11

Issuance & closing dates

Published last week of the month preceding date of issue.

Ad bookings close as published schedule.  
Refer Booking & Material deadlines Page.

No cancellations accepted after closing date.

Agency commission: (conditional on payment being made 
within 45 days from receipt of invoice)

Preferred RHP (Right Hand Page) positions incur 10% loading.

Specific position requests upon application.

winestate Magazine
4 Colour Advertisements

Casual 3 x Rate  6 x Rate 9 x Rate 12 x Rate

Double page Spread $18,000 $14,000 $11,000 $10,000 $8900

Full Page $10,000 $8000 $6000 $5500 $4900

Half Page $5900 $5500 $5000 $4700 $2900

Third Page $3300 $3000 $2700 $2500 $1500

Quarter Page $2800 $1600 $1400 $1300 $890

1/8 PAGE CLASSIFIED SECTION $595 $550 $495 $450 $425

Inside Front Cover $22,000 – Inside Back Cover $11,000 – Outside Back Cover $12,000

All rates subject to GST

4 Colour Advertisements
Casual 3 x Rate  6 x Rate 9 x Rate 12 x Rate

Double page Spread $24,000 $22,000 $19,000 $17,000 $15,000

Full Page $13,300 $11,600 $9900 $9000 $8000

Half Page $7600 $6560 $6600 $5500 $4500

Third Page $4900 $4700 $4400 $4000 $3700

Inside Front Cover $24,000 – Inside Back Cover $12,000 – Outside Back Cover $13,000

All rates subject to GST

advertising rates

Inserts: Full run only / prices available on application.

Frequency discount based on advertiser’s contract year.

Advertisement composition, art, retouching, typesetting and 
other services as required will be billed to the advertiser.

Material to be supplied by deadline otherwise publisher 
reserves the right to repeat previous advertisement or charge 
for space booked.

ONLINE ADVERTISING OPTIONS AVAILABLE WITH 
BANNER ADVERTISEMENTS OR LINKS.

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212 
e-mail sales@winestate.com.au website www.winestate.com.au
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Booking Deadline Material Deadline ON SALE

MARCH
      /April 11th January 18th January First week of March

MAY
      /June 5th March 12th March First week of May

JULY
      /August 7th May 14th May First week of July

SEPTEMBER
      /October 2nd July 9th July First week of September

NOVEMBER
      /December 3rd of September 10th September First week of November

ANNUAL &  
Wine of the 
Year Awards
January/
February

29th October 

5th November
Special Material sizes 
please refer to:  
ANNUAL Edition  
- artwork sizes or  
www.winestate.com.au

First week of January 2022
Re-Released July 2022

booking & material deadlines

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212 
e-mail sales@winestate.com.au website www.winestate.com.au

Disclaimer * Please refer to our Terms & Conditions on www.winestate.com.au
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Winestate, Australia’s longest running wine magazine, has gone digital with the help of 
one of the world’s most pre-eminent digital reader companies, Zinio. www.zinio.com

Winestate Digital offers ease of use. 

For those with sight impairment or who just want an easier 
read, that’s not so hard on the ol’ peepers, Winestate Digital 
has a zoom function that makes it very comfortable. 

A search function is also available for when you just can’t 
remember where you saw that elusive wine or topic of 
interest in your current issue. 

Winestate subscribers who live overseas no longer have to 
wait to get their issue, they’ll receive it the same time that 
Winestate hits newsstands here! 

This makes giving Winestate Digital as a gift for friends and 
loved ones a great idea!

Log on to www.winestate.com.au subscribe now!

digital

So why are we so excited about Winestate Digital? 

Well, because it’s a fantastic complement to our print version. 
Winestate Digital allows for greater interactivity, so whether 
you are perusing our Grapevine section and spot a great 
restaurant that you would like to check out, or are searching 
our contact details page and want to get a direct link to that 
winery, it’s all available at the click of a button.  
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winestate on-line

Our online site is used by wine connoisseurs globally to 
research information about the best of Australian wines.  
Many of the users of our website are current subscribers to 
the magazine or use the site for latest news.

Rankings on most search engines puts it generally in the top 
10 wine sites.

We have consistently maintained an average of 11 million hits 
per annum on the site.

There is a number of exciting user friendly functions on our 
site for wine buyers/consumers to use. These include access 
to stories as well as sort functions for wine reviews by region, 
variety, winery, vintage & price.

We currently have around 12,000 reviews on this site going 
back to 2014. Around 10% are viewed for free with out log 
in and an additional 25% can be viewed simply by registering 
details (still free) To access the remaining reviews users of the 
site can subscribe to a paid subscription.

All the reviews that are viewed for FREE are the reviews in the 
magazine with either bottle or label shots supplied alongside 
the review. In addition these reviews have the winery website 
details and contact e-mail below the actual review.

• More than 1 Million page views each year.

• Nearly 11 Million Hits each year.

• Over 94,935 page views per month.

• Over 3000 page views per day.

• Over 18,000 unique user sessions per per month.

• Over 216,000 unique user sessions per annum.

• Active database of newsletter subscribers.

www.winestate.com.au

winestate magazine on-line

www.winestate.com.au - RATE CARD
Sponsored Links on Home Page
6 month minimum

$500 per month*

Links $500 per year*

Premium Links with Logo $1500 per year*

Direct Marketing via our  
Winestate e-newsletter

P.O.A

All rates shown are GST exclsuive

*Can be supplied free of charge if print advertising is purchased.  
Contact sales@winestate.com.au for details.

Some Key Points:

• More than 1 Million page views each year.

• We can run banner advertising.

• Packages for banner ad placement & for links available.

online
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Winestate, Australia’s longest running wine magazine is online at www.winestate.com.au. 
To maximise your impact to your target audience and successfully advertise and market your 
business why not place a banner advert on our website. For website advertising inquiries 
please contact: sales@winestate.com.au

website banner adverts 
material requirements

Banner ads can be either created or designed by your 
own graphic design or marketing department or with the 
Winestate Inhouse designer at a cost (contact production@
winestate.com.au).

Website Banner Ad Specs:

All Banner ads must be within the specs listed below.

• Resolution to be 72 DPI

• RGB colour

• Sized at 160 pixels wide x 600 pixels high

• The file can either be a png or jpeg file or it can be an 
  animated gif file.

• All banner ads must be linked to a company website,  
 please provide a website for linking.

• Artwork can be emailed directly to production@winestate. 
 com.au or by using a file sharing service such as Dropbox  
 or WeTransfer for large files.

Examples of  
Banner ads

YOUR  
Online Banner 
ADVERT HERE

YOUR  
Online Banner 
ADVERT HERE
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Advertising Policies and Content Guidelines
• All Advertiser Content must be in good taste and must comply with all laws, rules and regulations that apply to the Advertiser, the  
 Advertiser Content and any location where the advertisements may appear.

• The landing page must prominently present the offer being advertised. Example: If the advertisement offers 25% off, then the landing 
 page must feature the products that are 25% off.

• Non-specific calls to action (e.g. “Click here”) are not allowed. Specific calls are acceptable.

• Advertising promoting sweepstakes may or may not be allowed, subject Winestate Magazine’s prior written approval.

• Advertising “free” goods or services must indicate that terms and conditions apply.

• The following advertising and advertising content is prohibited:

• Pornography and other “adult” content.

• Illicit/illegal drugs and drug paraphernalia.

• Gambling or gambling paraphernalia, including online gambling, poker, or bingo.

• Tobacco or tobacco related products.

• Weapons, including guns, gun parts, kits, mace, nunchucks, halberds, blank powder and ammunition.

• Foul, vulgar or obscene language or that features nudity.

• Content that is defamatory, libelous, invasive of another’s privacy.

• Hate speech - inciting or advocating violence or racial intolerance.

• Content that is threatening, abusive, harassing, or advocate against a protected group, whether based on race, color, national origin,  
 religion, disability, sex, sexual orientation, age or any similar or other category.

• Content that promotes any illegal or dangerous activity.

• Deceptive, false or misleading content.

• Content or technology that infringes, or encourages or enables the infringement of, the intellectual property or personal rights of  
 others.

Technical Specifications - General Technical Guidelines
• Advertisements must not collect any information from or about individual users (whether or not such information is personally  
 identifiable) without Winestate Magazine’s prior written consent.

• All advertisements must be in-banner and not expand, either automatically or by mouse roll-over.

• All advertisements must not include pop-ups and pop-unders, nor may landing pages spawn pop-up or pop-under advertisements to a  
 user.

• Winestate Magazine does not allow ads with flashing, a lot of animation, “fake winner” copy or fake functionality such as HTML Selects  
 or “Search Forms” in HTML or Flash or image format.

• If an advertisement uses third party tags, please include specific trafficking instructions. A contact at the third party is required and must  
 be provided to Winestate Magazine prior to the campaign.

• All impression delivery and billing will be based on Winestate Magazine reporting numbers unless otherwise specified in the applicable  
 insertion order.

• If Advertising Content is late or do not meet guidelines noted herein, Winestate Magazine reserves the right to extend the campaign  
 by the number of days the Advertising Content was late in order to reach the contracted impression goals. However, Winestate  
 Magazine will work with the applicable advertiser or agency to deliver all impressions within the contracted flight dates pending  
 placement and available inventory.

• Advertisements may not use Winestate Magazine or Winestate logos or trademarks or mention or refer to Winestate, its site or its  
 brand in any manner without Winestate Magazine’s prior written consent.

• Ads must incorporate advertiser’s trademark. The messaging should not mislead the user.

• Advertisements must not interfere with navigation on Winestate Magazine website, obscure other content or advertisements, access  
 or alter computer settings or preferences or otherwise unduly or inappropriately interfere with the user’s experience of or Winestate  
 Magazine’s operation of Winestate Magazine websites.

• Advertisements must not trigger downloads of software to a user’s computer without first providing the user with clear and  
 conspicuous disclosures regarding the installation, operation and removal of the software, and providing the user with an opportunity  
 to decline to install the software after such disclosures are made

• The display URL must be the actual destination URL (i.e., the website that the advertisement’s link resolves to, not a redirect) of the  
 advertisement so that it informs the user of the destination website of the advertisement.

• The destination URL of an advertisement must work properly and resolve to a working website. It cannot connect to an email address  
 or file, and must not be under construction.
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STICKERS ORDER FORM
STICKERS PRICE per 1000 @ $75.00 (incl GST if applicable)
Price negotiable for large orders, contact sales@winestate.com.au

5 STARS 

Qty_______________

4 ½ STARS 

Qty_______________

Recommended by Winestate 

Qty_______________

4 STARS 

Qty_______________

Best Value Buys $20 & Under 

Qty_______________

Best in Class

Qty_______________

Wine of the Year  
Trophy Winner 

Qty_______________

SUB - TOTAL $

Postage $

TOTAL $

DELIVERY DETAILS

Company Name

Contact Name

Postal Address for stickers

Postcode

Postal Address for invoice

Postcode

Prices are in Australian Dollars (please contact us for postage prices as they will vary). 
See contact details section below.

STICKER ARTWORK IS ACTUAL SIZE

BEST
VALUE
BUYS
BEST
VALUE
BUYSM

A
G A Z I

N
E

W
IN

ESTATE

Please send Australian order form to:   F: +61 8 8357 9212  |  E: administration@winestate.com.au

Please send NZ order form (GST free) to:    F: +64 09 479 1253   |  E: winestate@xtra.co.nz 
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EE SS TT   II NN   CC LL AA SS SS

W
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E of the YEA
R

T
R

O
P H Y  W I N

N

E
R

CONTACT DETAILS
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Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212

Winestate Magazine
Regional Features

Winestate Magazine
Style Features COPY DATE DUE

MAY
      /June

Wines of NSW

McLaren Vale & Fleurieu (incl 
Langhorne Creek & Kangaroo 
Island)

Western Australia

New Releases

4th March
2021

North Island (Wairarapa, Gisborne, Auckland & Northland)

JULY
      /August

River Regions

Adelaide Hills

Cabernet Sauvignon  
& Blends

Bordeaux Blend Varieties, 
Merlot, Cab Franc, Malbec, 
Petit Verdot

Organic Wines

Fortified & Sweet White 
Wines

New Releases

3rd May
2021

South Island (Nelson, Canterbury)

SEPTEMBER
      /October

Limestone Coast

Clare Valley

Shiraz/Syrah & Blends 

Semillon & Blends 

Pinot Noir

Emerging Varietal Awards 
(EVA)

New Releases

28th June
2021

Otago (Central Otago and Waitaki Valley, in North Otago) 

NOVEMBER
      /December

Tasmania

Queensland

Dry Riesling & Blends

Sauvignon Blanc & Blends

Pinot Gris/Grigio

Sparkling Wines

Rosé

New Releases

Spirits
30th August

2021

Hawkes Bay (NZ)

ANNUAL &  
Wine of the 
Year Awards
January/
February

Wine of the Year Awards  
Taste-off Trophy Judging Results

All the four- to five-star wines
of the year in review.
Re-released in July 2022.

New Releases
11th October

2021

See www.winestate.com.au for updates 
*Tasting dates and deadlines are subject to change

MARCH
      /April

Barossa Valley, Eden Valley

Central & Western Victoria

Chardonnay & Blends

Italian & Spanish Varietals 

New Releases 
10th January

2022

Marlborough (NZ)

editorial calendar
2021

2022

2022

2021

2021

2021

2021
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 cover specifications

Trim size with 5mm bleed

210mm wide 
x 297mm deep 

220mm wide 
x 307mm deep

Insure type is 15mm from the gutter. Keep all important information 50mm 
from the top of the page and 10mm from the bottom of the page.

Allow 50mm from the top 
to allow for the masthead

5mm bleed
supplying images to WINESTATE

When sending images please DO NOT downsize the file 
when e-mailing. 
Artwork can be emailed directly to production@winestate.
com.au or by using a file sharing service such as Dropbox or 
WeTransfer for large files.
4 RGB JPGs, EPS and Tiff’s will be accepted. 
7 DO NOT supply images in Word files or Power-Point.

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print result.  
If you have any further questions please do not hesitate to call your advertising consultant.

artwork sizes

Trim size with 5mm bleed

Double page: 420mm wide x 297mm deep 430mm wide x 307mm deep

Insure type is 15mm from the gutter. Keep all important information 10mm from the top and bottom of your page.

Full page: 210mm wide x 297mm deep 220mm wide x 307mm deep

Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page.
Keep all important information 10mm from the top and bottom of the page.

Half page vertical: 

Half page horizontal:

90mm wide x 270 mm deep

178mm wide x 135mm deep

N/A

N/A

Third page vertical:
 
Third page horizontal:

59mm wide x 270mm deep
 
178mm wide x 90mm deep

N/A
 
N/A

Quarter page square:
 
Quarter page horizontal:

90mm wide x 135mm deep

178mm wide x 68mm deep
N/A

1/6 page: 55mm wide x 135mm deep N/A

1/8 page CLASSIFIED: 87mm wide x 65mm deep N/A

FOLD

gutter

gutter

material requirements
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These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print
result. If you have any further questions please do not hesitate to call your advertising consultant.

artwork sizes - ANNUAL Edition
Trim size with 5mm bleed

Double page: 488mm wide x 305mm deep 498mm wide x 315mm deep

Insure type is 15mm from the gutter. Keep all important information 10mm from the top and bottom of your page.

Full page: 244mm wide x 305mm deep 254mm wide x 315mm deep

Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page.
Keep all important information 10mm from the top and bottom of the page.

Half page vertical: 

Half page horizontal:

102mm wide x 274 mm deep

208mm wide x 137mm deep

N/A

N/A

Third page vertical:
 
Third page horizontal:

67mm wide x 274mm deep
 
208mm wide x 91mm deep

N/A
 
N/A

Quarter page:

Quarter page horizontal:

102mm wide x 137mm deep 

 208mm wide x 68mm deep
N/A

1/6 page: 68mm wide x 135mm deep N/A

FOLD

gutter

gutter

material requirements

ANNUAL EDITION ONLY
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supplying advertisements to WINESTATE

1 File Formats
We prefer files supplied as print ready PDF’s. We also accept hi-resolution tiffs and eps files. 
Native files must be provided with links and fonts.
If size permits you can e-mail advertisement to: production@winestate.com.au

2 Images
Each image you use should have the following attributes:
1. CMYK color mode
2. 300dpi (dots per inch)
Once the image has been converted to 300dpi and is the size you need it in the advertisement, 
in Adobe Photoshop please view it at Actual Pixels (100%) (under View in main menubar). 
At any percentage other than 100%, you’re probably not seeing a fully accurate view of your image.

3 Flatten artwork and embedded fonts
All artwork should be flattened. Layers in Photoshop should be flattened and ALL transparencies  
in InDesign flattened. All fonts must be embedded.

4 Gutter and trim
Make sure type is 15mm from the gutter, remember your advertisement could  
be on a left or right hand page.
Keep all important information 10mm from the top and bottom of your page.

5 Blacks
All black type must be 100% black. For example C=0% , M=0%, Y=0%, K=100% 
(4 colour black will not be accepted)
Solid blacks should be a rich black. For example C=20% , M=0%, Y=0%, K=100%

6 Hard Copies
Please provide a hard copy colour proof when supplying artwork. 

7 Always check your artwork in Adobe Preflight before sending to WINESTATE
See following page for more information.

8 Material to be supplied by deadline otherwise publisher reserves the right to repeat previous  
advertisement or charge for space booked.

PAGE GUTTER

BACK COVER
TRIM: Width: 210mm

 Height: 297mm

BLEED: Width: 220mm
 Height: 307mm

SPECIFICATIONS - covers

5mm bleed

SPINE

INSIDE FRONT
TRIM: Width: 210mm

 Height: 297mm

BLEED: Width: 220mm
 Height: 307mm

*NOTE: 15mm gutter on
right hand side. Please keep 
important information away
from this area as it may get 

lost in the fold.

5mm bleed

SPINE

GUTTER*

INSIDE BACK
TRIM: Width: 210mm

 Height: 297mm

BLEED: Width: 220mm
 Height: 307mm

*NOTE: 15mm gutter on
left hand side. Please keep 

important information away
from this area as it may get 

lost in the fold.

material requirements
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Checking artwork in

Acrobat 7.0 Professional Preflight

This is a MUST before submitting supplied artwork.

1 Open your PDF in Adobe Acrobat 
(version 7 shown in example).

2 Advanced (in main menubar) > Preflight

b) Make sure Overprint Preview is ticked

3 Click on “List all Images” > Execute

4 Click down on the information icon.
This will list all the images in pixels per inch and the 
colour mode for all images. Please make sure all 
images are 300dpi (ppi) and CMYK.

5 Other things to check:

List non-embedded fonts > Execute
List transparent objects > Execute

material requirements
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Creating a PDF from

InDesignCS4

It is important to start the export process with a clean file. 
Please make sure the document has been carefully proof 
read, all colours are correct, all fonts available and images 
are linked properly.  
This can be checked in InDesignCS4: File>Package

material requirements

1 File menu > export

2 Saving your Adobe PDF.

Select the location you would like to save your PDF,  
create a file name and > save.

2 General
Select ‘WINESTATE’ from the Adobe PDF Preset drop down menu. 
If this is the first time creating a PDF for Winestate, follow all the steps 
first and click on ‘Save Preset’ before you click Export.

Select PDF/X-4:2008 from the Standard drop down menu.
Select Acrobat 5 (PDF 1.4) from the Compatibility drop down menu.

3 Compression 
Colour Images > select ‘Bicubic Downsampling to’  
from the drop down menu > 300 Pixels per inch   
for images above  > 450 pixels per inch 
Compression > Automatic (JPEG) 
Image Quality > Maximum

Greyscale Images > select ‘Bicubic Downsampling to’  
from the drop down menu > 300 Pixels per inch   
for images above  > 450 pixels per inch 
Compression > Automatic (JPEG) 
Image Quality > Maximum

Monchrome Images > select ‘Bicubic Downsampling to’  
from the drop down menu > 1200 Pixels per inch   
for images above  > 1800 pixels per inch 
Compression > CCITT Group 4

Select > Compress Text and Line Art. 
Select > Crop Image Data to Frames.

4 Marks and Bleeds
Click ‘All Printer’s Marks’ will select all marks for the PDF.
Click ‘Use Document Bleed Settings’ should be set at 5mm 
around the entire document. FILE > Document Setup > Bleed.
*Only add bleed if you are sending a full page, double page,  
or cover advertisements.
If you are sending a 1/6, quarter page, half or third page horizontal 
or a half or third page vertical you do not require bleed.
Set Offset to 4mm.
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material requirements

5 Output
Colour Conversion should be set to No Colour Conversion.
Inks – The only inks showing should be Process Cyan,
Magenta, Yellow, Black. If you have other colours showing,
you need to go to the Ink Manager button, and check on
the All Spot to Process box.

Creating a PDF from

InDesignCS4 cont.

6 Advanced
Job Definition Format should be un-ticked.

7 Security
Does not need to be created.

8 Summary
Make sure nothing issues with creating your PDF under the 
Options list.

A. B.

9 Save and export PDF

A. If you regularly send artwork to WINESTATE Save Preset. 
Next time you can skip all the above steps.

B. Export your PDF after you have gone through all the tabs.

10 Check PDF in Acrobat Preflight > See relevant page


